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COMPUTER BASIC SKILLS CLASS OUTLINE 
 

Week 1: Introduction 

a. Computer parts (Key board and mouse importance) 

b. Operative systems (Windows, Linux, and Apple) 

c. History of memory disks 

d. How to recognize a “good” computer 

e. Keyboard and typewriting 

f. Memorizing important “Control” formulas 

g. Free Computer Software (Office, Photoshop, Virus) 

h. Obtaining an e-mail account  

Week 2: Current Technology; The Computer and the Internet 

a. How to recognize the operative system in your computer 

b. How to translate a Newspaper (Sample: Spanish Newspaper to English) 

c. How to translate a document a Document or a Website 

d. Recognizing “Start” and its programs 

e. Microsoft Word (Version 2010 and 2013) Open a New Document (Control “N”) 

f. The File Tab (Importance of knowing “where we are at”) 

Week 3: Using Microsoft Word: The Home Tab 

a. Font Type, Font Size 

b. Bold, Italic, and Underline 

c. Font Color 

d. Paragraph Position 

e. Numbers and … 

f. Copy and Paste (Control “C” and Control “V”) 

g. El Zorro Tool (Control “Z”) 

Week 4: Using Microsoft Word: The Inset Tab 

a. Table 

b. Picture 

c. Clip Art 

d. Shapes 

e. Text Box 

f. Word Art 

g. Symbol 

h. Using Pictures: The Format Tools (Tools, Borders and Colors, Position and movements, Crop 

and…) 

Week 5: Using Microsoft Word: The Page Lay Out; The Mailing Tab; and the Review Tab 

a. Page Orientation, Columns, Watermark, and Page Color 

b. Envelopes and Labels 

c. Spelling and Grammar; Thesaurus; and Word Count 

Week 6: Using Microsoft Word: The View and Print Tools and Other Microsoft Office Programs 

a. The View Tools: Page width and Whole Page 

b. The Save Tool (Control “S”) and The Print Tool (Control “P”) 

c. Publishing and Creating 

d. Using Microsoft Publisher. Recognizing Tools Learned in Microsoft Word 

e. Using Microsoft Power Point: Recognizing Tools Learned in Microsoft Word 



 

 
3 
 

COMPUTER PARTS: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

MONITOR 

CPU BOX 

KEYBOARD 

MOUSE 

FLOPPY DRIVER 

CD DRIVER 

How to turn on a computer 
  

Step 1: Find the ‘on’ button. 

Step 2: Push the button. 

Step 3: Now you need to log in. 

USB PORT 

How to turn off a computer 
  

Step 1: Click the ‘Windows’ button at 

the bottom left-hand corner of your 

screen. 

Step 2: Click Shut down or 
Click Cancel and then close everything that had been listed in 

the message, saving when necessary. Then try closing again. 

OR 
Click Force shut down. The computer will automatically close 

all your documents, programs and so on without saving 

anything.  
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OPERATIVE SYSTEM: 

 

 

HISTOY OF MEMORY DISK: 
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MOUSE PARTS: 

 

 

 

KEY BOARD PARTS: 
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KEY BOARD & TYPEWRITING: 

 

 

 

FREE ONLINE TYPING PROGRAMS: 

 
 Typing Trainer: www.typingtrainer.com/  

 Ense-Lang.org: www.sense-lang.org/typing/tutor/keyboarding.php  

 Good typing: www.goodtyping.com/default.htm  

 Interactive Sites for Education: www.interactivesites.weebly.com/typing.html  

 

TYPING TIPS: 

 Hit keys only with the fingers for which they have been reserved.  

 Always return to the starting position of the fingers "ASDF – JKL;".  

 When typing, imagine the location of the symbol on the keyboard.  

 Establish and maintain a rhythm while typing. Your keystrokes should come at 

equal intervals.  

 The SHIFT key is always pressed by the pinky finger opposite to the one hitting 

the other key.  

 Use the thumb of whichever hand is more convenient for you to press the Space 

bar. 

http://www.typingtrainer.com/
http://www.sense-lang.org/typing/tutor/keyboarding.php
http://www.goodtyping.com/default.htm
http://www.interactivesites.weebly.com/typing.html


 

 
7 
 

IMPORTANT COMPUTER PROGRAMS: 

Security and system optimization (FREE) 

 CCleaner: Optimization management:  https://www.piriform.com/ccleaner  

 Avast!: Antivirus software: https://www.avast.com/en-us/index  

 Malwarebytes: Anti-malware software: https://www.malwarebytes.org/  

Productivity (FREE) 

 LibreOffice: A full-featured office suite: http://www.libreoffice.org/  

 Open Office: A full-featured office suite: http://www.openoffice.org/  

 Thunderbird: Email management software: https://www.mozilla.org/en-

US/thunderbird/  

 Metapad: An advanced text editor: http://liquidninja.com/metapad/  

 Foxit Reader: A PDF viewer: https://www.foxitsoftware.com/products/pdf-

reader/   

 CutePDF: A PDF writer that works like a virtual printer: 

http://www.cutepdf.com/Products/CutePDF/writer.aspv  

Media (FREE) 

 Paint.NET: A simple image editor: http://www.getpaint.net/index.html  

 GIMP: A complex and powerful image editor: http://www.gimp.org/  

 VLC media player: A cross-platform multimedia player: 

http://www.videolan.org/  

 K-Lite Codec Pack Standard: A multimedia player package: 

http://www.codecguide.com/download_k-lite_codec_pack_standard.htm  

 Dropbox: Cloud storage, file synchronization, and file hosting: 

https://www.dropbox.com/  

FREE ONLINE HANDHOUTS:  www.amauta.info  
 

 

 Computer Classes schedule and Computer Manual 

https://www.piriform.com/ccleaner
https://www.piriform.com/ccleaner
https://www.avast.com/
https://www.avast.com/en-us/index
https://www.malwarebytes.org/
https://www.malwarebytes.org/
http://www.libreoffice.org/
http://www.libreoffice.org/
http://www.openoffice.org/
http://www.openoffice.org/
https://www.mozilla.org/en-US/thunderbird/
https://www.mozilla.org/en-US/thunderbird/
https://www.mozilla.org/en-US/thunderbird/
http://liquidninja.com/metapad/
http://liquidninja.com/metapad/
http://www.foxitsoftware.com/Secure_PDF_Reader/
https://www.foxitsoftware.com/products/pdf-reader/
https://www.foxitsoftware.com/products/pdf-reader/
http://www.cutepdf.com/Products/CutePDF/writer.asp
http://www.cutepdf.com/Products/CutePDF/writer.aspv
http://www.getpaint.net/
http://www.getpaint.net/index.html
http://www.gimp.org/
http://www.gimp.org/
http://www.videolan.org/
http://www.videolan.org/
http://www.codecguide.com/download_k-lite_codec_pack_standard.htm
http://www.codecguide.com/download_k-lite_codec_pack_standard.htm
https://www.dropbox.com/
https://www.dropbox.com/
http://www.amauta.info/
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 Control “O” 

 Control “N” 

 Control “S” 

 Control “P” 

VERY IMPORTANT INSTRUCTIONS: 
 

In every class we will follow this format to facilitate the learning process: 

 

1. The Instructor will teach the subject and students will follow the 

instructor focusing in what the instructor is teaching on the 

whiteboard or the image projected on the screen.  Students will not 

use the computer at this point. 

2. The Instructor and the Students together will use the computers 

applying the instruction given. 

3. The Student will work alone with the computer and ask for help if 

needed. 

 

VERY IMPORTANT INSTRUCTIONS ABOUT TOOLS: 

 
We will be focusing on learning Microsoft 2010-2013.  The following tools after the first 

week, will be used all the times.  Please, be familiar with these tools. 

 

 

 Copy 

 Paste 

 Font Type 

 Font Size 

 Bold, Italic… 

 Font Color 

 Paragraph 

 Numbers and… 

 Tables 

 Picture 

 Online Pictures 

 Shapes 

 Text Box 

 Word Art 

 Watermark 

 Page Color 

 Page Borders 

 

 Page Orientation 

 Columns 

 Bring Forward 

 Send Backward 

 Review “Design” 

 

 Spelling & Grammar 

 Thesaurus 

 Word Count 

 Zoom 

 One Page 

 Whole Page 
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HOW TO OPEN AN E-MAIL ACCOUNT IN YAHOO: 

 

Figure 1 

Sign In 

First 

Figure 2 
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Figure 3 
INSTRUCTION: Return Figure 2 

Figure 4 
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Figure 5 

Figure 6  

IMPORTANT Figure 7  

Figure 8 

SUMMARY 
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 www.amauta.info 
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HOW TO TRANSLATE - SAMPLE: 
 

1) Go to: www.amauta.info 

2) Select “U.S. and World Newspapers” 

3) In “World Newspapers” Go to “South America” and Select “Argentina”  

4) Select “La Nacion” (This is a Hispanic Newspaper) 

 

 

 

 

 

5) Copy the Web address: http://www.lanacion.com.ar/  (1st
 highlight and 2) Do Control “C”) 

6) Go back to:  www.amauta.info 

7) Select “”Translator” at the bottom of the website 

 

8) Paste (Control “V”) the website address: http://www.lanacion.com.ar/ in the new screen 

9) In “Auto-Detect” select “Spanish” 

10) Click “Translate” 

 

It is possible to translate any website following the same process. 

 

 

 

 

http://www.amauta.info/
http://www.lanacion.com.ar/
http://www.amauta.info/
http://www.lanacion.com.ar/
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HOW TO REGOGNIZE YOUR OPERATIVE SYSTEM 
 

1.Click the Start button, usually found in the lower left corner of the main Desktop 

screen. 

2.Click the Run or Search field, type winver, and press Enter. 

 

IMPORTANT INFORMATION: 

Formulas Easy to Memorize 

 

1. Control “N”=  New 

2. Control “O”=  Open 

3. Control “S”=  Save 

3. Control “P”=  Print 

4. Control “C”= Copy 

5. Control “Z”= El Zorro 

6. Control “A”= The Dark 

Knight Rises 

 

SPANISH KEYS 

1. Alt + 160 = á 

2. Alt + 161 = í 

3. Alt + 162 = ó 

4. Alt + 163 = ú 

5. Alt + 164 = ñ 

6. Alt + 165 = Ñ 

7. Alt + 168 = ¿ 

8. Alt + 130 = é 

Check next page 

 

 

My Computer Information 
1. Open 
2. Go to OS (C) 
3. Right Click your mouse 

4. Go to Properties 

My Documents 
 

Search Programs and Files 
 

All Programs 
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How to Open a Document 

 
In our Computer Basic Skill Class, we will be using Word 2013.   

 

1) Go to start and select “All Programs” 

 

2) Select “Microsoft Office 2013” and then “Word 2013 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

Be sure that you are on Word 2013. 
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3) Open a “Blank Document” 

 

4) Check your new document by looking at the top of your screen. 

 

5) REVIEW PAGE # 8 or 18 – “TOOLS” 
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BASIC COMPUTERS SKILLS MAIN TOOLS 
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MICROSOFT WORD 2010: 

 

 

MICROSOFT OFFICE 

2010 

Microsoft Word 2010 
 

Microsoft Office 
 

ALWAYS “CHECK” THIS TAB 
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FILE TAB 

 

 

 

 

 

 

 

 

 

1. Control “N”=  New 

2. Control “O”=  Open 

3. Control “S”=  Save 

3. Control “P”=  Print 

4. Control “C”= Copy 

5. Control “P”= Paste 

6. Control “Z”= El Zorro 

7. Control “A”= Highlight 

SPANISH KEYS 

1. Alt + 160 = á 

2. Alt + 161 = í 

3. Alt + 162 = ó 

4. Alt + 163 = ú 

5. Alt + 164 = ñ 

6. Alt + 165 = Ñ 

7. Alt + 168 = ¿ 

8. Alt + 130 = é 
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HOME TAB 

 

 

 

 

 

 

 

 

 

 

 

 

Font Type 

 

Bold - Italic- Underline 

 

Font Size 

 

Font Color 

 

Paragraph Position 

 

Numbers and… 

 

IMPORTANT  ICON 
 

Spacing 

 

Control “A” 
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HOME TAB: Font Type 

 

HOME TAB: Font Color 

 

Control “A” 
To change fonts and pictures 

IMPORTANT 
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HOME TAB: Number and… 

 

HOME TAB: Spacing Options 

 

Space 1 

Space 2 

Space 3 
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HOME TAB: Copy and Paste 
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INSERT TAB: 

 

 

 

 

 

 

 

 

Shapes: 

 

                          Word Art: 

 

 

 

 

            Text Box: 

 

 

 

 

 

 

Table 

 
Clip Art 

 

Shapes 

 

Picture 

 

Text Box 

 

Word Art 

 
Symbol 
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INSERT TAB: Table 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 2 

4 3 

5 
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INSERT TAB: Shapes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INSERT TAB: Word Art 
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PAGE LAYOUT TAB: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PAGE LAYOUT TAB: Page Color 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page Orientation 

 
Columns 

 
Watermark 

 
Page Color 
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MAILING TAB: Mailing and Labels 

 

 

 

 

REVIEW TAB: Spelling & Grammar, Thesaurus, and Word Count 

 

 

 

 

 

Spelling and 

Grammar 

 

Thesaurus 

 
Word Count 
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REVIEW TAB: Spelling & Grammar 

 

 

REVIEW TAB: Thesaurus                            REVIEW TAB: Word Count 

 

 

 

 

Incorrect Word 
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VIEW TAB: Zoom                            

 

 

 

 

FORMAT TAB (Picture Tools:) 

 

 

 

 

 

 

 

 

 

 

Picture Tools 

 

Picture Tools: 

Borders Colors 

and Intensity 

 

IMPORTANT

Picture 

Position and 

Movement 

 

Picture Crop 

Tool 
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FORMAT TAB: Brightness & Contrast     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FORMAT TAB: Wrap Text/Picture, Picture Arrange and Picture Crop  

 

 

 

 

 

 

 

 

FORMAT TAB: Borders Colors and Weight     
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FINALLY!!!  

 

FILE TAB: Print 

 

FILE TAB: Save or Save As 
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(SAMPLE) Finding Specific Information in a Text File:  

  
1) Find the text File and do Control “F” 

 

 

2) Type “Reservation” and click “Next” (Sample) 

 - There are 36 times the word “Reservations” 

 - The word in the document is highlighted  
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OTHER PROGRAMS – MICROSOFT PUBLISHER: 

 

OTHER PROGRAMS – MICROSOFT POWER POINT: 
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OPPORTUNITIES TO LEARN ONLINE: 

 
GCF LearnFree.org: www.gcflearnfree.org/  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

U.S. Small Business Administration: www.sba.gov  

 

http://www.gcflearnfree.org/
http://www.sba.gov/

